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Preface

This guide describes the system and client requirements, installation procedures, 
and troubleshooting suggestions for the CiscoWorks Common Services software.

Audience
This guide is for anyone who installs, configures, verifies, and uses CiscoWorks 
Common Services software. Network administrators or operators should have the 
following skills:

• Basic Solaris system administrator skills

• Basic network management skills

Conventions
This document uses the following conventions:

Item Convention

Commands and keywords boldface font

Variables for which you supply values italic font

Displayed session and system information screen font

Information you enter boldface screen font
vii
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Conventions
Note Means reader take note. Notes contain helpful suggestions or references to 
material not covered in the publication. 

Caution Means reader be careful. In this situation, you might do something that could 
result in equipment damage or loss of data.

Variables you enter italic screen font

Menu items and button names boldface font

Selecting a menu item in paragraphs Option > Network Preferences

Seleting a menu item in tables Option > Network Preferences

Item Convention
viii
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Product Documentation
Product Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should review the documentation on Cisco.com for 
the latest updates.

Table 1 describes the product documentation that is available.

Table 1 Product Documentation

Document Title Available Formats

Release Notes for CiscoWorks 
Common Services 2.2 (Includes 
CiscoView 5.5) on Solaris

• Printed document that was included with the product.

• On Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/c
w2000/cw2000_d/comser22/index.htm

Installation and Setup Guide for 
Common Services (Includes 
CiscoView) on Solaris

• PDF on the product CD-ROM.

• On Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/c
w2000/cw2000_d/comser22/ig_solcv/index.htm

• Printed document available by order (part number 
DOC-7815431=).1

1. See the “Obtaining Documentation” section on page xi.

User Guide for CiscoWorks 
Common Services

• PDF on the product CD-ROM.

• On Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/c
w2000/cw2000_d/comser22/usrguide/index.htm

• Printed document available by order (part number 
DOC-7815301=).1

Context-sensitive online help • Select an option from the navigation tree, then click Help.

• Click the Help button in the dialog box.
ix
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Related Documentation

Note We sometimes update the printed and electronic documentation after original 
publication. Therefore, you should review the documentation on Cisco.com for 
the latest updates.

Table 2 describes the additional documentation that is available.

Table 2 Related Documentation

Document Title Available Formats

User Guide for CiscoView 5.5 • On Cisco.com at:

http://www.cisco.com/univercd/cc/td/doc/product/rtrmgmt/c
w2000/cw2000_d/comser22/use_view/index.htm

• Printed document available by order (part number 
DOC-7815219=).1
x
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Obtaining Documentation
Obtaining Documentation
Cisco provides several ways to obtain documentation, technical assistance, and 
other technical resources. These sections explain how to obtain technical 
information from Cisco Systems.

Cisco.com
You can access the most current Cisco documentation on the World Wide Web at 
this URL:

http://www.cisco.com/univercd/home/home.htm

You can access the Cisco website at this URL:

http://www.cisco.com

International Cisco websites can be accessed from this URL:

http://www.cisco.com/public/countries_languages.shtml

Documentation CD-ROM
Cisco documentation and additional literature are available in a Cisco 
Documentation CD-ROM package, which may have shipped with your product. 
The Documentation CD-ROM is updated regularly and may be more current than 
printed documentation. The CD-ROM package is available as a single unit or 
through an annual or quarterly subscription.

Registered Cisco.com users can order a single Documentation CD-ROM (product 
number DOC-CONDOCCD=) through the Cisco Ordering tool:

http://www.cisco.com/en/US/partner/ordering/ordering_place_order_ordering_t
ool_launch.html

All users can order monthly or quarterly subscriptions through the online 
Subscription Store:

http://www.cisco.com/go/subscription
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Obtaining Documentation
Ordering Documentation
You can find instructions for ordering documentation at this URL:

http://www.cisco.com/univercd/cc/td/doc/es_inpck/pdi.htm

You can order Cisco documentation in these ways:

• Registered Cisco.com users (Cisco direct customers) can order Cisco product 
documentation from the Networking Products MarketPlace:

http://www.cisco.com/en/US/partner/ordering/index.shtml

• Nonregistered Cisco.com users can order documentation through a local 
account representative by calling Cisco Systems Corporate Headquarters 
(California, U.S.A.) at 408 526-7208 or, elsewhere in North America, by 
calling 800 553-NETS (6387). 

Documentation Feedback
You can submit comments electronically on Cisco.com. On the Cisco 
Documentation home page, click Feedback at the top of the page.

You can e-mail your comments to bug-doc@cisco.com.

You can submit comments by using the response card (if present) behind the front 
cover of your document or by writing to the following address:

Cisco Systems
Attn: Customer Document Ordering
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
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Obtaining Technical Assistance
Cisco provides Cisco.com, which includes the Cisco Technical Assistance Center 
(TAC) website, as a starting point for all technical assistance. Customers and 
partners can obtain online documentation, troubleshooting tips, and sample 
configurations from the Cisco TAC website. Cisco.com registered users have 
complete access to the technical support resources on the Cisco TAC website, 
including TAC tools and utilities. 

Cisco.com
Cisco.com offers a suite of interactive, networked services that let you access 
Cisco information, networking solutions, services, programs, and resources at any 
time, from anywhere in the world. 

Cisco.com provides a broad range of features and services to help you with these 
tasks:

• Streamline business processes and improve productivity 

• Resolve technical issues with online support

• Download and test software packages

• Order Cisco learning materials and merchandise

• Register for online skill assessment, training, and certification programs

To obtain customized information and service, you can self-register on Cisco.com 
at this URL:

http://tools.cisco.com/RPF/register/register.do

Technical Assistance Center
The Cisco TAC is available to all customers who need technical assistance with 
a Cisco product, technology, or solution. Two types of support are available: the 
Cisco TAC website and the Cisco TAC Escalation Center. The type of support 
that you choose depends on the priority of the problem and the conditions stated 
in service contracts, when applicable.
xiii
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Obtaining Technical Assistance
We categorize Cisco TAC inquiries according to urgency:

• Priority level 4 (P4)—You need information or assistance concerning Cisco 
product capabilities, product installation, or basic product configuration. 
There is little or no impact to your business operations.

• Priority level 3 (P3)—Operational performance of the network is impaired, 
but most business operations remain functional. You and Cisco are willing to 
commit resources during normal business hours to restore service to 
satisfactory levels.

• Priority level 2 (P2)—Operation of an existing network is severely degraded, 
or significant aspects of your business operations are negatively impacted by 
inadequate performance of Cisco products. You and Cisco will commit 
full-time resources during normal business hours to resolve the situation.

• Priority level 1 (P1)—An existing network is “down,” or there is a critical 
impact to your business operations. You and Cisco will commit all necessary 
resources around the clock to resolve the situation.

Cisco TAC Website

The Cisco TAC website provides online documents and tools to help troubleshoot 
and resolve technical issues with Cisco products and technologies. To access the 
Cisco TAC website, go to this URL:

http://www.cisco.com/tac

All customers, partners, and resellers who have a valid Cisco service contract 
have complete access to the technical support resources on the Cisco TAC 
website. Some services on the Cisco TAC website require a Cisco.com login ID 
and password. If you have a valid service contract but do not have a login ID or 
password, go to this URL to register:

http://tools.cisco.com/RPF/register/register.do

If you are a Cisco.com registered user, and you cannot resolve your technical 
issues by using the Cisco TAC website, you can open a case online at this URL:

http://www.cisco.com/tac/caseopen

If you have Internet access, we recommend that you open P3 and P4 cases online 
so that you can fully describe the situation and attach any necessary files.
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Cisco TAC Escalation Center

The Cisco TAC Escalation Center addresses priority level 1 or priority level 2 
issues. These classifications are assigned when severe network degradation 
significantly impacts business operations. When you contact the TAC Escalation 
Center with a P1 or P2 problem, a Cisco TAC engineer automatically opens a 
case.

To obtain a directory of toll-free Cisco TAC telephone numbers for your country, 
go to this URL:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

Before calling, please check with your network operations center to determine the 
Cisco support services to which your company is entitled: for example, 
SMARTnet, SMARTnet Onsite, or Network Supported Accounts (NSA). When 
you call the center, please have available your service agreement number and your 
product serial number.

Obtaining Additional Publications and Information
Information about Cisco products, technologies, and network solutions is 
available from various online and printed sources.

• The Cisco Product Catalog describes the networking products offered by 
Cisco Systems, as well as ordering and customer support services. Access the 
Cisco Product Catalog at this URL:

http://www.cisco.com/en/US/products/products_catalog_links_launch.html

• Cisco Press publishes a wide range of networking publications. Cisco 
suggests these titles for new and experienced users: Internetworking Terms 
and Acronyms Dictionary, Internetworking Technology Handbook, 
Internetworking Troubleshooting Guide, and the Internetworking Design 
Guide. For current Cisco Press titles and other information, go to Cisco Press 
online at this URL:

http://www.ciscopress.com
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Obtaining Additional Publications and Information
• Packet magazine is the Cisco quarterly publication that provides the latest 
networking trends, technology breakthroughs, and Cisco products and 
solutions to help industry professionals get the most from their networking 
investment. Included are networking deployment and troubleshooting tips, 
configuration examples, customer case studies, tutorials and training, 
certification information, and links to numerous in-depth online resources. 
You can access Packet magazine at this URL:

http://www.cisco.com/go/packet

• iQ Magazine is the Cisco bimonthly publication that delivers the latest 
information about Internet business strategies for executives. You can access 
iQ Magazine at this URL:

http://www.cisco.com/go/iqmagazine

• Internet Protocol Journal is a quarterly journal published by Cisco Systems 
for engineering professionals involved in designing, developing, and 
operating public and private internets and intranets. You can access the 
Internet Protocol Journal at this URL:

http://www.cisco.com/en/US/about/ac123/ac147/about_cisco_the_internet_
protocol_journal.html

• Training—Cisco offers world-class networking training. Current offerings in 
network training are listed at this URL:

http://www.cisco.com/en/US/learning/le31/learning_recommended_training
_list.html
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C H A P T E R 1

Prerequisites

This chapter describes the factors that you should consider before installing 
CiscoWorks Common Services on a Solaris system. It contains:

• Product Overview

• Server Requirements

• Client Requirements

• Supported Devices

• Supported Network Management System Environments

Product Overview
CiscoWorks Common Services software, the foundation for the CiscoWorks 
family of products and other Cisco product families, enables the deployment, 
monitoring, and troubleshooting of devices across your network. CiscoWorks 
Common Services includes:

• CiscoWorks Common Services 2.2—A set of shared application services. 

• CiscoView 5.5—A graphical device management tool.

• Integration Utility 1.5—An integration module that supports third-party 
network management systems (NMS).
1-1
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Chapter 1      Prerequisites
Server Requirements
CiscoWorks Common Services Upgrade
Table 1-1 describes the different local upgrade paths and results. See the 
“Installing CiscoWorks Common Services” chapter for installation instructions.

Server Requirements
The minimum system requirements for installing CiscoWorks Common Services 
are shown in Table 1-2.

Table 1-1 Upgrade Paths

Existing Software Results

Clean machine CiscoWorks Common Services is installed in the specified directory.

CiscoWorks 
Common Services 
2.2

Reinstallation of CiscoWorks Common Services 2.2 overwrites the previously 
installed CiscoWorks Common Services components. All data is preserved.

CD One, 5th Edition CiscoWorks Common Services 2.2 overwrites the previously installed
CiscoWorks Common Services components. All data is preserved.

CD One, 4th Edition CiscoWorks Common Services 2.2 overwrites the previously installed 
CiscoWorks Common Services components. All data is preserved.

Table 1-2 Server System Requirements 1

Requirement Type Minimum Requirements

System hardware • Sun Sparc Ultra 102.

• 17-inch color monitor.

• CD-ROM drive.

Memory (RAM) 512 MB (to install all CiscoWorks Common Services components).

Available drive space • 2 GB on the partition on which you install the product (the 
default is /opt).

• Swap space equal to double the amount of memory (RAM). For 
example, if your system has 256 MB of RAM, you need 
512 MB of swap space.
1-2
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Chapter 1      Prerequisites
Server Requirements
Caution Do not use non standard java options through _JAVA_OPTIONS environment 
variable.

To verify the amount of available disk space in each of the specified partitions and 
directories, enter:

# df -k directory

where directory is the partition or directory for which you want to check the 
available disk space.

System software Solaris 2.7 and Solaris 2.8

Note CiscoWorks Common Services 2.2 supports only 
US-English and Japanese versions of Solaris Operating 
Systems. It does not support any other language version. Set 
the default locale to US-English for US-English version and 
Japanese for Japanese version.

Additional software (Optional) Netscape Navigator 4.76 (if you are using the desktop on the server 
system).

Caution For Solaris, use Netscape Navigator downloaded from 
Sun site only.

1. Minimum requirements vary, depending on which components you choose to install: 
Integration Utility alone requires 128 MB RAM and 50 MB disk space.
CiscoView alone requires 128 MB RAM and 96 MB disk space.

2. CiscoWorks Common Services supports Ultra SPARC III machines such as Sun-Fire-280R, Netra-T4, Sun Blade 1000 too.

Table 1-2 Server System Requirements (continued)1

Requirement Type Minimum Requirements
1-3
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Server Requirements
Solaris Patches
Table 1-3 lists the required and recommended patches for Solaris 2.7 and 2.8.

Use the showrev -p command to verify that these patches have been applied.

Table 1-3 Solaris Patches

Operating System Required Recommended

Solaris 2.7 106980-10

106327-05

107081-11

107636-03

108376-03

112300-01

108301-02

108482-02

Solaris 2.8 111626-01

111327-02

110945-02

110934-01

110898-02

110700-01

109326-05

108827-30

108652-51

108528-18

108921-14

108940-24

110951-01

110662-02

110615-01

110286-02

109324-02

111085-02

108964-06
1-4
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Client Requirements
Client Requirements
The minimum system requirements for the client are shown in Table 1-4. For 
information about configuring client systems, see the “Preparing to Use 
CiscoWorks Common Services” chapter.

Note If Java Console is not listed in View, you must enable it.

Table 1-4 Client System Requirements

Requirement Type Minimum Requirements

System hardware 
and software

• Client system:

– IBM system with at least a 300 MHz Pentium processor running 
Windows (Professional and Server), or Windows XP SP1.

– Sun SPARC Ultra 10 running Solaris 2.7, Solaris 2.8.

• Color monitor with video card set to 24 bits color depth.

Memory (RAM) 256 MB.

Browser One of these browsers:

On Windows and Windows XP clients:

• Microsoft Internet Explorer 6.0 (version 6.0.2600.0000) or Internet Explorer 
6.0 with Service Pack 1 (version 6.0.2800.1106), 

• Java Virtual Machine (JVM) 5.0.0.3802 and later, and Java Plug-in version 
1.3.1.

To verify the JVM:
From Internet Explorer, select View > Java Console. 
From Netscape Navigator, select Tools > Server > Java Console.

• Netscape Navigator 4.78 and 4.79 for Windows.

On Solaris clients:

• Netscape Navigator 4.76 for Solaris 2.7 and 2.8.

Caution For Solaris, use Netscape Navigator downloaded from Sun site only.
1-5
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Supported Devices
Enabling Java Console
To enable Java console in Microsoft Internet Explorer:

Step 1 Select Tools > Internet Options > Advanced. 

Step 2 In the Microsoft VM section, select the Java Console enabled. 

Step 3 Restart Internet Explorer.

Supported Devices
CiscoView manages and configures different types of Cisco devices. See Using 
CiscoView 5.5 for supported device information.

Supported Network Management System 
Environments

The network management system (NMS) supported for importing device 
information into the CiscoView application is HP OpenView Network Node 
Manager. See Using CiscoView 5.5 and the online help for information about 
importing devices.
1-6
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C H A P T E R 2

Installing CiscoWorks Common 
Services

This chapter consists of:

• Installation Overview

• Preparing to Install CiscoWorks Common Services

• Performing a New Installation

• Performing an Upgrade Installation

• Uninstalling CiscoWorks Common Services

Installation Overview
This section provides overview of CiscoWorks Common Services installation 
task. Table 2-1 contains references to more detailed information about each task. 
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Preparing to Install CiscoWorks Common Services 
Before you install CiscoWorks Common Services, make sure your server and 
client environments meet the hardware and software requirements described in the 
“Prerequisites” chapter.

You must have administrative privilege to install CiscoWorks Common Services.

Using the Server IP Address
CiscoWorks uses the IP address of the server when it interacts with web browsers. 
By using the server IP address, CiscoWorks eliminates name lookup failures 
between the server and the client systems that run web browsers.

Table 2-1 Installing CiscoWorks Common Services Task Overview

Task Steps References

Prepare to install 
CiscoWorks 
Common Services.

1. Verify server requirements are 
met.

“Prerequisites” chapter, “Server 
Requirements” section on page 1-2 

2. Verify client requirements are 
met.

“Prerequisites” chapter, “Client 
Requirements” section on page 1-5

3. Verify TCP ports that 
CiscoWorks uses and check for 
conflicts with existing 
applications.

“TCP and UDP Ports Used” section on 
page 2-3

Install server 
software.

Run installation program. “Performing a New Installation” section 
on page 2-5 

“Performing an Upgrade Installation” 
section on page 2-17

Verify and 
troubleshoot 
installation.

Analyze installation error messages. “Troubleshooting the Installation” 
appendix, “Understanding Installation 
Messages” section on page A-4 
2-2
Installation and Setup Guide for Common Services (Includes CiscoView) on Solaris

78-15431-01



 

Chapter 2      Installing CiscoWorks Common Services
Preparing to Install CiscoWorks Common Services
TCP and UDP Ports Used
CiscoWorks Common Services uses the following TCP and UDP ports.

Incoming Ports

The following ports are used for incoming traffic:

• 42343/tcp (JRun)

• 57860/tcp (JRun Server Manager ControlServer - Used for Jrun 
Administration)

• 514/udp (Standard port for Syslog)

• 1741/tcp (port used for the CiscoWorks HTTP server)

• 1742/tcp (used when the webserver is running on SSL mode)

See the “Preparing to Use CiscoWorks Common Services” chapter for 
information on accessing the server.

• Database ports: 43441- 43449 (The ports used by different apps are different. 
For example, CiscoWorks Common Services uses 43441 and Essentials uses 
43442)

• 443/tcp (port used for Core Apache Web server in SSL mode)

• 9007/tcp (Ajp12 connector used by Tomcat)

• 9009/tcp (Ajp13 connector used by Tomcat)

• 1751/tcp (port used for the Core Apache Web server).

Outgoing Ports

The following ports are used for outgoing traffic:

• 161/udp (Standard port for SNMP Polling)

• 162/udp (Standard port for SNMP Traps)

• 23/tcp (Standard port for Telnet)

• 22/tcp (Standard port for SSH)

• 80/tcp (Default HTTP for device navigator).
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Incoming and Outgoing Ports

The following ports are used for incoming and outgoing traffic:

• 42340/tcp (CiscoWorks Daemon Manager, the tool that manages server 
processes)

• 42342/udp (Osagent)

• 7580/tcp (default port; alternate port: 42352/tcp) (ESS HTTP port)

• 69/udp (Standard port for TFTP)

• 1683 (IIOP port for CWCS gatekeeper)

• 8088 (HIOP port for CWCS gatekeeper)

• 514/tcp (RCP port)

• 42351/tcp (default port; alternate port: 44351/tcp) (ESS Listening port)

• 42353/tcp (default port; alternate port: 44353/tcp) (ESS Routing port)

• 42350/udp (default port; alternate port: 44350/udp (ESS Service port) 

• 10033 (licensing database port)

• 1684/tcp (IIOP gatekeeper port).

System Files Modified During Installation
The system files modified during CiscoWorks Common Services installation are:

• /etc/services

• /etc/inetd.conf

• /etc/syslog.conf

• /etc/passwd

• /etc/group

• /var/sadm/install/admin/default

• /var/sadm/install/contents

• /etc/shadow
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Performing a New Installation
The CiscoWorks Common Services installation program takes approximately 20 
minutes to complete on a Solaris system with the minimum required hardware. 
This can extend to one hour if you perform network management integration 
during the installation process.

For information on setting up multi-homed systems, see the Release Notes for 
CiscoWorks Common Services 2.2 (includes 5.5) on Solaris. 

Running the Installation Program—New Installation
To run the installation program: 

Step 1 As root, mount the CiscoWorks Common Services CD-ROM using either of the 
following methods:

• Mount the CD-ROM on the CiscoWorks Common Services server system.

or

• Mount the CD-ROM on a remote Solaris system, then access the 
CD-ROM from the CiscoWorks Common Services server system.

Caution Network inconsistencies may cause installation errors while installing from a 
remote mount point.

See the “Mounting and Unmounting on Solaris” appendix for detailed mounting 
instructions.

Step 2 Run the installation program.

• For a local installation, enter:

# cd /cdrom/cdrom0/
# ./setup.sh 

• For a remote installation, enter:

# cd remotedir
# ./setup.sh
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where remotedir is the remote location where the CD-ROM is mounted.

A message appears:

Press Enter to read/browse the following license agreement:

Step 3 Press Enter to read the license agreement. 

The following message appears at the end of the license agreement:

You must accept this License agreement for the installation to 
proceed.
If you enter N/n, the installation will exit. 
Do you accept all the terms of the preceeding License Agreement ? 
(y/n) [y]

Step 4 Enter y to accept the license and proceed with the installation.

or 

Enter n to deny and stop the installation.

Step 5 Select one of the following:

• Express to install all CiscoWorks Common Services components in the 
default location with default settings. (See the “New Installation—Express” 
section.)

• Typical to select CiscoWorks Common Services components, and install the 
selected components in a specific location. (See the “New 
Installation—Typical” section.) This is the default installation mode.

• Custom to select optional components, customize the settings, and to specify 
the location. (See the “New Installation—Custom” section.) 

The installation program performs several preinstallation and dependency checks 
on your system, such as TCP/IP address resolution, TCP/IP port use, disk space, 
and RAM. 

Caution Installation of CiscoWorks Common Services might fail on Solaris 2.8, if Sun 
patch version 110934-20 or higher is installed. For more information, see the 
known problem CSCsa34490 in the Release Notes for CiscoWorks Common 
Services 2.2 (Includes CiscoView 5.5) on Solaris.
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New Installation—Express
If you select the Express option:

Step 1 Press Enter to start installation.

The installation program installs CiscoWorks Common Services in the default 
directory /opt/CSCOpx

The installation program checks dependencies and system requirements.

If the drive does not have enough space, the following error message appears and 
the installation exits:

ERROR: Not enough disk space: location you selected for installation.

Step 2 Enter the CiscoWorks Admin Password and confirm it.

The installation proceeds.

After the installation has completed, a message appears:

Do you want to see the passwords that were entered/randomly generated? 
If yes, please remember that passwords are security sensitive data and 
hence make sure they are kept secure ? (y/n) [y]

Select y, to see randomly generated passwords.

Step 3 Unmount the CD-ROM. See the “Mounting and Unmounting on Solaris” 
appendix for details.

Note Error messages or warning messages appear if the required and recommended 
Solaris patches are not present on your system. Before running CiscoWorks 
Common Services, download and install the latest recommended patches from 
www.sunsolve.sun.com.
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If errors occurred during installation, check the installation log file 
/var/tmp/ciscoinstall.log. Each installation appends to this file. For 
troubleshooting information, See the “Troubleshooting the Installation” 
appendix.

To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.

New Installation—Typical
If you select the Typical option:

Step 1 Press Enter to start installation.

A message appears:

Enter the location where the product will be installed or q to quit. 
Default location (PKGROOT)? [/opt/CSCOpx]

CiscoWorks Common Services requires a directory named /opt/CSCOpx. If you 
select a different installation directory, the /opt/CSCOpx directory will be created 
and will be a link to the directory you selected.

Caution Do not remove the link after installation. The product will not work without 
this link. 

Step 2 Press Enter to accept the default directory for product installation, or enter a 
different directory. 
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Step 3 Select one or more of the following:

1. CiscoWorks Common Services 2.2 (CWCS) to install the CiscoWorks 
Common Services.
(Select this option only if you do not want CiscoView 5.5 or Integration 
Utility1.5 installed.)

2. CiscoView 5.5 to install both CiscoView and CiscoWorks Common Services.

3. Integration Utility 1.5.
(For information about the Integration Utility and third-party NMS 
integration, see Using CiscoView.) 

4. All of the Above to install all CiscoWorks Common Services components 
(recommended for most systems.)

You can select more than one component using the corresponding numbers 
separated by comma. For example, enter 1, 3 to select CiscoWorks Common 
Services and Integration Utility. 

Step 4 Enter the number corresponding to the option you have chosen or q to quit.

Step 5 Enter the CiscoWorks Admin Password and confirm it.

For more information on passwords see “Password Information”.

Step 6 Press Enter. 

If the casuser exists, a message appears:

Warning: User casuser already exists, the installation process will 
overwrite its previlage.
Do you want to proceed with the installation ? [y/n]

Casuser is the user who administers and maintains CiscoWorks Server without 
having administrative privileges. 
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Press Enter if you receive the casuser message. The installation program adds the 
new casuser and the new group casusers to the system.

The installation proceeds.

After installation is complete, a message appears:

Do you want to see the passwords that were entered/randomly generated? 
If yes, please remember that passwords are security sensitive data and 
hence make sure they are kept secure ? (y/n) [y]

Select y to see randomly generated and manually entered passwords.

Step 7 Unmount the CD-ROM. See the “Mounting and Unmounting on Solaris” 
appendix for details.

Note Error messages or warning messages appear if the required and recommended 
Solaris patches are not present on your system. Before running CiscoWorks 
Common Services, download and install the latest recommended patches from 
www.sunsolve.sun.com.

If errors occurred during installation, check the installation log file 
/var/tmp/ciscoinstall.log. Each installation appends to this file. For 
troubleshooting information, See the “Troubleshooting the Installation” 
appendix.

To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.
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New Installation—Custom
If you select the Custom option:

Step 1 Press Enter to start installation.

A message appears:

Enter the location where the product will be installed or q to quit. 
Default location (PKGROOT)? [/opt/CSCOpx]

CiscoWorks Common Services requires a directory named /opt/CSCOpx. If you 
select a different installation directory, the /opt/CSCOpx directory will be created 
and will be a link to the directory you selected.

Caution Do not remove the link after installation. The product will not work without 
this link. 

Step 2 Press Enter to accept the default directory for product installation, or enter a 
different directory. 

The installation program displays:

Select one or more  items using its number separated by comma or enter 
q to quit.

Step 3 Select one or more of the following:

1. CiscoWorks Common Services 2.2 (CWCS) to install CiscoWorks 
Common Services.
(Select this option only if you do not want CiscoView 5.5 or Integration 
Utility1.5 installed.)

2. CiscoView 5.5 to install CiscoView 5.5 and CiscoWorks Common Services 
2.2.

3. Integration Utility 1.5.
(For information about the Integration Utility and third-party NMS 
integration, see Using CiscoView 5.5.) 

4. All of the Above to install all CiscoWorks Common Services components 
(recommended for most systems.)
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You can select more than one component using the corresponding numbers 
separated by comma. For example, enter 1, 3 to select CiscoWorks Common 
Services and Integration Utility. 

Step 4 Enter the number corresponding to the option you have chosen or q to quit.

Step 5 Enter the CiscoWorks Admin Password and confirm it. 

For more information on passwords, see “Password Information”.

Step 6 Enter Guest Password and confirm it.

For more information on passwords, see “Password Information”.

Step 7 Press Enter. 

If the casuser exists, a message appears:

Warning: User casuser already exists, the installation process will 
overwrite its previlage.
Do you want to proceed with the installation? [y/n]

Press Enter if you receive the casuser message. The installation program adds the 
new casuser and the new group casusers to the system.

Step 8 Enter the CiscoWorks Common Services Database Password and confirm it.

For more information on passwords, see “Password Information”.

A message appears.

Should Access Control Server (ACS) be used for user authentication ? 
(y/n) [n]

Step 9 If you choose to use ACS for user authentication, enter the following:

• ACS name

• ACS administrator’s account

• ACS administrator’s password

• ACS secret key
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Step 10 Enter the following Apache Certificate information:

• SMTP server

• Host name

• Adminstrator’s e-mail address

• Country 

• State 

• City 

• Company 

• Organization 

Host name is mandatory.

Step 11 Enter and confirm the Licensing Database Password. 

For more information on passwords, see “Password Information”.

If you have selected Integration Utility, the following message appears:

The integration utility will be installed now. The integration utility 
integrates Cisco device packages and Cisco applications into 
third-party SNMP management platforms. You can choose to integrate 
with a third-party SNMP management platform during this installation 
or later.
Do you want to integrate with a third-party product now (y/n) [n]

Step 12 Select one of the following:

• n to integrate with a third-party NMS after installation. This completes the 
installation faster and avoids installation failure caused by errors in the third 
party integration.

• y to integrate with a third-party NMS during installation.
If you choose to integrate now, follow steps a to d.

a. Select the adapter from the list of available adapters, or select other to 
choose an adapter that is not listed (you will be prompted to enter the path 
name of the adapter), or select none to integrate after the installation is 
complete. 
If you select none, skip to Step 13.
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Note If you are installing only the Integration Utility, enter the CiscoWorks 
Server name, protocol type (HTTP, HTTPS) and port number.

b. Enter the HTTP browser location, or press Enter to accept the default 
location, /opt/netscape/netscape.

A message appears asking if you want to enable download options from 
the Cisco Web page (Cisco.com).

c. Select one of the following:

– n to disallow future upgrades from the Cisco Web page.

– y to enable future upgrades from the Cisco Web page.

d. Enter your Cisco.com user ID and password.

Note You must have Cisco.com login privileges. If you do not have a user 
account and password on Cisco.com, contact your channel partner or 
enter a request on the standard Cisco.com web site.

The installation proceeds.

After installation is complete, a message appears:

Do you want to see the passwords that were entered/randomly generated? 
If yes, please remember that passwords are security sensitive data and 
hence make sure they are kept secure ? (y/n) [y]

Select y to see randomly generated and manually entered passwords.

Step 13 Unmount the CD-ROM. See the “Mounting and Unmounting on Solaris” 
appendix for details.

Note Error messages or warning messages appear if the required and recommended 
Solaris patches are not present on your system. Before running CiscoWorks 
Common Services, download and install the latest recommended patches from 
www.sunsolve.sun.com.
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If errors occurred during installation, check the installation log file 
/var/tmp/ciscoinstall.log. Each installation appends to this file. For 
troubleshooting information, See the “Troubleshooting the Installation” 
appendix.

To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.
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Installing CiscoWorks from a mounted directory
To install CiscoWorks Common Services from a mounted directory:

Step 1 Log in to the remote system.

Step 2 Enter: 

cd /etc/dfs/dfstab 

Step 3 Enter:

share -F nfs -o root=r /the directory where you have the installable 
image

Step 4 Stop and start the NFS server using the following commands:

/etc/init.d/nfs.server stop
/etc/init.d/nfs.server start

Step 5 Log in to the local system.

Step 6 Enter : 

mount remote system:/the directory where you have the installable 
image /the local directory where you want to mount the remote system

Step 7 Enter :

cd /the local directory where you mounted the remote system

Step 8 Enter:

./setup.sh

See the “Mounting and Unmounting on Solaris” appendix for detailed mounting 
instructions.
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Performing an Upgrade Installation
CiscoWorks Common Services 2.2 supports upgrade from:

• CD One, 5th edition

• CD One, 4th edition

The data is preserved when you perform an upgrade.

For a description of the different upgrade paths and their results, see the “Upgrade 
Paths” section on page 1-2.

To perform a local upgrade, see the “Upgrading CiscoWorks Common 
Services—Local Upgrade” section on page 2-17.

To perform a remote upgrade, see the “Upgrading CiscoWorks Common 
Services—Remote Upgrade” section on page 2-26.

Upgrading CiscoWorks Common Services—Local Upgrade
You can upgrade from:

• CD One, 5th Edition

• CD One, 4th Edition

We recommend that you save your data to a backup file before you perform the 
local upgrade. If your installation fails, you can retrieve this saved data. 

Backing Up Your Data

To backup your data:

Step 1 Access the CiscoWorks desktop and log in. For information, see Accessing the 
Server and Logging sections in the User Guide for CiscoWorks Common Services. 

Step 2 Select Server Configuration > Administration > Database Management > 
Back Up Data Now.

The Back Up Data Now dialog box appears.
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Step 3 Enter the path name of the target directory. 

It is recommended that you use a different directory from the directory where 
CiscoWorks is located, for example, /cw/backups.

Step 4 To begin the backup, click Finish. 

This process may take some time to complete.

For more information, see the online help.

Running the Installation Program

To run the installation program: 

Step 1 Install the required patches as described in the “Solaris Patches” section on 
page 1-4.

Step 2 As root, mount the CiscoWorks Common Services CD-ROM using either of the 
following methods:

• Mount the CD-ROM on the CiscoWorks Common Services server system.

or

• Mount the CD-ROM on a remote Solaris system, then access the 
CD-ROM from the CiscoWorks Common Services server system.

Caution Network inconsistencies may cause installation errors while installing from a 
remote mount point.

See the “Mounting and Unmounting on Solaris” appendix for detailed mounting 
instructions.
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Step 3 Run the installation program.

• For a local installation, enter:

# cd /cdrom/cdrom0/
# ./setup.sh 

• For a remote installation, enter:

# cd remotedir
# ./setup.sh

where remotedir is the remote location where the CD-ROM is mounted.

The license agreement appears. 

Step 4 Enter y to accept the license and proceed with the installation. 

or

Enter n to deny and stop the installation.

Step 5 Select one of the following:

• Express to install all CiscoWorks Common Services components in the 
default location with default settings (See the “Upgrade 
Installation—Express” section.)

• Typical to select CiscoWorks Common Services components, and install the 
selected components in a specific location (See the “Upgrade 
Installation—Typical” section.) This is the default installation mode.

• Custom to select optional components, customize the settings, and to specify 
the location (See the “Upgrade Installation—Custom” section.)

The installation program performs several preinstallation and dependency checks 
on your system, such as TCP/IP address resolution, TCP/IP port use, disk space, 
and RAM.
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Upgrade Installation—Express
If you select the Express option:

Step 1 Press Enter to start installation.

The installation program installs CiscoWorks Common Services in the directory 
where the earlier version is installed.

The installation program checks dependencies and system requirements.

If the drive does not have enough space, an error message appears and the 
installation of CiscoWorks Common Services exits:

ERROR: Not enough disk space: location you selected for installation.

If you have not entered a password for CiscoWorks admin or guest user during 
the previous installation, a warning appears:

The password for the cwuser user is empty. For security reasons you 
must change the password as soon as you can from CiscoWorks Desktop.

Where cwuser is either CiscoWorks admin or guest.

The installation proceeds.

After the installation is complete,a message appears:

Do you want to see the passwords that were entered/randomly generated? 
If yes, please remember that passwords are security sensitive data and 
hence make sure they are kept secure ? (y/n) [y]

Select y to see randomly generated and manually entered passwords.

Step 2 Unmount the CD-ROM. See the “Mounting and Unmounting on Solaris” 
appendix for details.

Note Error messages or warning messages appear if the required and recommended 
Solaris patches are not present on your system. Before running CiscoWorks 
Common Services, download and install the latest recommended patches from 
www.sunsolve.sun.com.
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If errors occurred during installation, check the installation log file 
/var/tmp/ciscoinstall.log. Each installation appends to this file. For 
troubleshooting information, See the “Troubleshooting the Installation” 
appendix.

To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.

Upgrade Installation—Typical
If you select the Typical option:

Step 1 Press Enter to start installation.

The installation program installs CiscoWorks Common Services in the directory 
where the earlier version is installed.

The installation program checks dependencies and system requirements.

If the drive does not have enough space, an error message appears and the 
installation of Common Services exits:

ERROR: Not enough disk space: location you selected for installation.

If you have not entered a password for CiscoWorks admin or guest user during 
the previous installation, a warning appears:

The password for the cwuser user is empty. For security reasons you 
must change the password as soon as you can from CiscoWorks Desktop.

Where cwuser is either CiscoWorks admin or guest.

The installation proceeds.

After installation is complete, a message appears:

Do you want to see the passwords that were entered/randomly generated? 
If yes, please remember that passwords are security sensitive data and 
hence make sure they are kept secure ? (y/n) [y]

Select y to see randomly generated and manually entered passwords.

Step 2 Unmount the CD-ROM. See the “Mounting and Unmounting on Solaris” 
appendix for details.
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Note Error messages or warning messages appear if the required and recommended 
Solaris patches are not present on your system. Before running CiscoWorks 
Common Services, download and install the latest recommended patches from 
www.sunsolve.sun.com.

If errors occurred during installation, check the installation log file 
/var/tmp/ciscoinstall.log. Each installation appends to this file. For 
troubleshooting information, See the “Troubleshooting the Installation” 
appendix.

To prepare the client system for use. See the “Preparing to Use CiscoWorks 
Common Services” chapter.
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Upgrade Installation—Custom
If you select the Custom option:

Step 1 Press Enter to start installation. 

The installation program installs CiscoWorks Common Services in the directory 
where the earlier version is installed.

The installation program checks dependencies and system requirements.

If the drive does not have enough space, an error message appears and the 
installation of Common Services exits:

ERROR: Not enough disk space: location you selected for installation.

Step 2 Enter the CiscoWorks Admin Password and confirm it. 

See “Password Information” appendix for detailed instructions on the usage of 
passwords.

Step 3 Enter Guest Password and confirm it. 

See the “Password Information” appendix for detailed instructions on the usage 
of passwords.

Step 4 Press Enter. 

If the casuser exists, a message appears:

Warning: User casuser already exists, the installation process will 
overwrite its previlage.
Do you want to proceed with the installation? [y/n]

Press Enter if you receive the casuser message. The installation program adds the 
new casuser and the new group casusers to the system.

Casuser is the user who administers and maintains CiscoWorks Server without 
having administrative privileges.

Step 5 Enter the CiscoWorks Common Services Database Password and confirm it. 

The following message appears:

Do you want to preserve the existing Apache Certificate? (y/n) [y]
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Step 6 Enter the following Apache certificate information:

• SMTP server

• Host name

• Administrator’s e-mail address

• Country 

• State 

• City 

• Company 

• Organization 

Step 7 Enter Licensing database Password.

See the “Password Information” appendix for detailed instructions on the usage 
of passwords.

If you have selected Integration Utility, the following message appears:

The integration utility will be installed now. The integration utility 
integrates Cisco device packages and Cisco applications into 
third-party SNMP management platforms. You can choose to integrate 
with a third-party SNMP management platform during this installation 
or later.

Do you want to integrate with a third-party product now (y/n) [n]

Step 8 Select one of the following:

• n to integrate with a third-party NMS after installation This complete the 
installation faster and avoids installation failure caused by errors in the third 
party integration.

• y to integrate with a third-party NMS during installation
If you choose to integrate now, follow steps a to d.

a. Select the adapter from the list of available adapters, or select other to 
choose an adapter that is not listed (you will be prompted to enter the path 
name of the adapter), or select none to integrate after the installation is 
complete. 
If you select none, go to Step 9.
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Note If you are installing only the Integration Utility, enter the CiscoWorks 
Server name, protocol type (HTTP, HTTPS) and port number.

b. Enter the HTTP browser location, or press Enter to accept the default 
location, /opt/netscape/netscape.

A message appears, asking if you want to enable download options from 
the Cisco Web page (Cisco.com).

c. Select one of the following:

– n to disallow future upgrades from the Cisco Web page.

– y to enable future upgrades from the Cisco Web page.

d. Enter your Cisco.com user ID and password.

You must have Cisco.com login privileges. If you do not have a user 
account and password on Cisco.com, contact your channel partner or 
enter a request on the standard Cisco.com web site.

The installation proceeds.

After installation is complete, a message appears:

Do you want to see the passwords that were entered/randomly generated? 
If yes, please remember that passwords are security sensitive data and 
hence make sure they are kept secure ? (y/n) [y]

Select y to see randomly generated and manually entered passwords.

Step 9 Unmount the CD-ROM. See the “Mounting and Unmounting on Solaris” 
appendix for details.

Note Error messages or warning messages appear if the required and recommended 
Solaris patches are not present on your system. Before running CiscoWorks 
Common Services, download and install the latest recommended patches from 
www.sunsolve.sun.com.
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If errors occurred during installation, check the installation log file 
/var/tmp/ciscoinstall.log. Each installation appends to this file. For 
troubleshooting information, See the “Troubleshooting the Installation” 
appendix.

Prepare the client system for use. See the “Preparing to Use CiscoWorks Common 
Services” chapter.

Upgrading CiscoWorks Common Services—Remote Upgrade
If you do not want to overwrite your current application you can perform a remote 
upgrade. During a remote upgrade you install CiscoWorks Common Services on 
a new system and export essential data to the new system from the system running 
the previous version. 

Step 1 Install CiscoWorks Common Services on the new system. See the “Performing a 
New Installation” section on page 2-5.

Step 2 Remove the CiscoWorks Common Services CD-ROM from the new system.

Step 3 Export essential data to the new system. The default location is 
/opt/CSCOpx/rigel

Note If you are upgrading from a previous edition of CiscoWorks Common Services, 
data from the system running the previous version must be exported to the new 
system. 
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Exporting the Data

To export the data:

Step 1 The CiscoWorks Common Services CD-ROM should be in the CD-ROM drive of 
the system running the old version of CiscoWorks Common Services. Go to the 
Root directory on the CiscoWorks Common Services CD-ROM.

Step 2 From the Root directory, run the script export_cdone.pl.

$NMSROOT /bin/perl export_cdone.pl

$NMSROOT is the directory in which CiscoWorks Common Services is installed. 
The default NMSROOT directory is /opt/CSCOpx. 
The script prompts you for the location where you want to store the data to be 
exported.

Step 3 Press Enter to accept the default location for storing the exported data.

The default location is /opt/CSCOpx/rigel.

If you do not want to use the default location enter an alternate location and press 
Enter.

The remote upgrade tool exports the data, and creates the directories cmf and 
manifest/cmf at the location specified for backing up the data. For example, if you 
choose /opt/backup as the back up location, the remote upgrade tool creates the 
directories /opt/backup/cmf and /opt/backup/manifest/cmf to store the exported 
data.

Step 4 Copy the directories cmf and manifest from the system running the old version of 
CiscoWorks Common Services into /opt/CSCOpx/rigel on the system running the 
new version of CiscoWorks Common Services.

Step 5 On the new system, go to the directory $NMSROOT/rigel/scripts, and run the 
script import_cdone.pl.

Step 6 Run the data import script:

$NMSROOT/bin/perl import_cdone.pl 

The remote upgrade tool imports the exported data from the remote system.
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The upgrade is now complete and all necessary data from the previous version of 
CiscoWorks Common Services has been exported.

Note During the remote upgrade the user information from the source is merged with 
the new user information.

Reinstalling CiscoWorks Common Services
To reinstall CiscoWorks Common Services, follow the steps under Performing an 
Upgrade Installation, page 2-17

You can change the installation mode during reinstallation. For Express and 
Typical installation, the passwords from the earlier installation are retained. For 
Custom mode, you need to provide new passwords.

Note If CiscoWorks Common Services has previously been installed on this 
system, the product will automatically be installed in the same location 
CiscoWorks Common Services was previously installed.

After you select the components, the following message displays:

CiscoWorks Common Services 2.2 has been detected on your system. Are 
you sure you want to reinstall (y/n)? [n]

Enter y to continue with the installation.

If you are installing in Express or Typical mode and if you have not entered a 
password for the CiscoWorks admin or guest user during the previous installation, 
a warning appears:

The password for the cwuser user is empty. For security reasons you 
must change the password as soon as you can from CiscoWorks Desktop.

Where cwuser is either CiscoWorks admin or guest.
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Uninstalling CiscoWorks Common Services
Use the uninstall script to remove CiscoWorks Common Services files and 
settings.

You cannot uninstall CiscoWorks Common Services when you have CiscoView 
and Integration Utility installed. Before uninstalling CiscoWorks Common 
Services, select CiscoView and CiscoWorks Common Services to uninstall 
CiscoWorks Common Services.

If you select CiscoWorks Common Services with out selecting CiscoView, the 
following message appears:

Cannot uninstall CiscoWorks Common Services.
It is required for CiscoView.

Uninstall all applications dependent on CiscoWorks Common Services before 
uninstalling CiscoWorks Common Services.

Caution You must use the uninstall script to remove the product. If you try to remove 
CiscoWorks Common Services or its components manually, you may damage 
your system.

To uninstall CiscoWorks Common Services:

Step 1 As root, enter the following commands to start the uninstall script:

# cd /
# /opt/CSCOpx/bin/uninstall.sh

where /opt/CSCOpx is the default installation directory.

A list of CiscoWorks components appears. Enter the number corresponding to the 
option you have chosen or q to quit. You can select more than one component. 
Enter the number corresponding to the components separated by comma.

Note When you remove CiscoWorks Common Services, the uninstall script 
removes changes made to the /etc/services file. The /etc directory still 
contains all system file changes. The uninstall messages are written to the 
/var/tmp/ciscouninstall.log file.
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After the uninstall is complete, a message appears:

All files were deleted successfully.

Step 2 Check the following files:

• /etc/syslog.conf for syslog changes. 

• /etc/services to ensure that port assignments for the CiscoWorks applications 
have been removed. 

• /etc/inetd.conf to ensure that CiscoWorks tftp entry is removed.
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Preparing to Use CiscoWorks 
Common Services

Now that you have installed CiscoWorks Common Services , you must configure 
the client system for CiscoWorks Common Services.

This chapter consists of:

• Configuring Server Systems

• Configuring Client Systems

• Accessing the Server

• Using CiscoView

Note The system that has CiscoWorks Common Services installed on it can be used as 
both the client and server. If you are using the system as client, you must 
configure the web browser.

Configuring Server Systems
Set the following environment variables for CiscoWorks system administrators. 
These variables are not required for tasks performed by users other than those 
with administrator privileges.

Add /opt/CSCOpx/bin, and /opt/CSCOpx/MDC/bin to the PATH variable in the 
.cshrc or .profile files of CiscoWorks Common Services users who have 
administrator privileges. 
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To set PATH variable:

In C shell:

Enter: 
$ set path=( /opt/CSCOpx/bin /opt/CSCOpx/MDC/bin $path)

In Bourne shell: 

Enter: 
# PATH=/opt/CSCOpx/bin:/opt/CSCOpx/MDC/bin:$PATH 
export PATH

Add /opt/CSCOpx/man to the MANPATH variable.

To set MANPATH variable:

In C Shell:

Enter:

setenv MANPATH ${MANPATH}:/opt/CSCOpx/man

In Bourne Shell:

Enter:

MANPATH=$MANPATH:/opt/CSCOpx/man 
export MANPATH

Configuring Client Systems
Configure your client system to use CiscoWorks Common Services.

Set Display Fonts
For Windows set the display to use small fonts:

Step 1 Select Start  >  Settings > Control Panel. 

The Control Panel window appears.
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Step 2 Double-click the Display icon. 

The Display Properties dialog box appears.

Step 3 Click the Settings tab. 

• If Small Fonts is selected in the Font Size list, your display font is set 
correctly.

• If Small Fonts is not selected, select it from the Font Size drop-down list, 
then click OK. 

The System Settings Change dialog box appears.

Step 4 If you changed the font size, click Yes to restart your system.

Configure Web Browser
To configure your web browser:

Step 1 Enable Java and JavaScript:

• Netscape Navigator—Select Edit  > Preferences > Advanced. Select the 
Enable Java and Enable JavaScript check boxes and click OK.

• Internet Explorer—Select Tools  >  Internet Options  > Advanced. Under 
the Microsoft VM heading, select Java console enabled, JIT compiler for 
virtual machine enabled, and Java logging enabled and click OK.

Caution Do not enable Java Plug-in in Netscape Navigator. Disable the Enable Java 
Plug-in option from Edit > Preferences >Advanced >Enable Java Plugin

Step 2 Set your browser cache to at least 6 MB:

• Netscape Navigator—Select Edit  >  Preferences  > Advanced  > Cache. Set 
both the memory cache and the disk cache to at least 6144 KB and click OK.

• Internet Explorer—Select Tools  > Internet Options  > General, then click 
Settings. Set the cache to at least 6 MB using the Amount of disk space to 
use slide bar. Click OK to close the Settings dialog box and return to the 
Internet Options dialog box and click OK again.
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Step 3 Configure your browser to accept all cookies:

• Netscape Navigator—Select Edit  >  Preferences >  Advanced. Select the 
Accept all cookies radio button and click OK.

• Internet Explorer—Select Tools >  Internet Options  > Privacy. Scroll the 
settings bar down to select Accept all Cookies. Click OK.

Step 4 Configure your browser to compare each page with its cached version every time 
it loads a page:

• Netscape Navigator—Select Edit  > Preferences >
Advanced >  Cache. Select the Every Time radio button and click OK.

• Internet Explorer—Select Tools  >  Internet Options > General, then click 
Settings under Temporary Internet files group. Select the Every visit to the 
page radio button and click OK twice.

Note This option must be set to prevent Internet Explorer from using the cached 
information for help links. If it is not set, the first help link is displayed 
properly. However, the second time you click a link, the first page is 
displayed again.

Step 5 Change the default timeout to 20 minutes. For more information on changing the 
timeout in Internet Explorer, see the instructions on the Microsoft Support Web 
site.

Step 6 Enable style sheets:

• Netscape Navigator—Select Edit > Preferences > Advanced. Select the 
Enable Style Sheets check box and click OK.

• Internet Explorer—Select Tools  >  Internet Options  > General, then click 
Accessibility. Make sure that the Format documents using my style sheet 
check box is not selected, then click OK to close the Accessibility dialog box, 
then click OK again to close the Internet Options dialog box.
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Step 7 Change the default font to sans-serif for improved readability:

• Netscape Navigator—Select Edit > Preferences  >  Appearance >  Fonts. 
Select a sans-serif font (for example, Arial) and a font size in the Variable 
Width Font and Fixed Width Font selection areas and click OK. The text 
in the browser window is redrawn using the new fonts.

• Internet Explorer—Select Tools  > Internet Options  > General and click 
Fonts. Select a sans-serif font (for example, Arial) from the Web page font 
and Plain text font lists, then click OK. Click OK to close the dialog box. 
The text in the browser window is redrawn using the new fonts.

If you have browser problems after configuring your browser, increase your disk 
cache settings.

After the web browser is installed on the client system, there are no additional 
disk space requirements. However, because the browser uses the local disk to 
store cached information, ensure that you have enough disk space for the amount 
of cached information you want to store. All CiscoWorks Common Services 
information is stored on the CiscoWorks Server.

Configure the Integration Utility
The Integration Utility allows you to launch CiscoView from an SNMP platform 
even when CiscoView is running on a different system than the NMS. It also 
allows you to integrate other applications into NMS menu.

See Using CiscoView 5.5 for information about configuring the Integration 
Utility. 
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Accessing the Server
CiscoWorks Common Services uses port 1741 for the HTTP server and port 1742 
for HTTPS server (SSL). 

To access the server from a client system, enter any one of these URLs in your 
web browser:

• If SSL is disabled and if you have installed CiscoWorks Common Services 
on the default port, and enter:

http://server_name:1741

• If SSL is enabled, and if you have installed CiscoWorks Common Services 
on the default port, enter:

https://server_name:1742

where server_name is the hostname of the server on which you installed 
CiscoWorks Common Services.

In addition, refer to the “TCP and UDP Ports Used” section.

In the main CiscoWorks desktop, the Login Manager appears. See User Guide for 
CiscoWorks Common Services for information on logging in.

Using CiscoView
CiscoView is a graphical SNMP-based device management tool that provides 
real-time views of networked Cisco Systems devices. 

See Using CiscoView 5.5 for information about launching and using CiscoView.
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Troubleshooting the Installation

This appendix provides troubleshooting information for CiscoWorks Common 
Services installation. It contains:

• Checking Processes After Installation

• Viewing and Changing Process Status

• Calling the Technical Assistance Center (TAC)

• Understanding Installation Messages

• Setting Up the Browser

Checking Processes After Installation
You can run a self test or view process failures from the CiscoWorks Server. 
To run a self test, select Server Configuration >  Diagnostics >  Self Test from 
the navigation tree. 

To view process failures, select Server Configuration >  Diagnostics  > Process 
Failures from the navigation tree.
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Viewing and Changing Process Status
This section explains how to view process status through menu or command line 
options.

Any CiscoWorks user can view the status of any process by selecting Server 
Configuration  > Administration > Process Management > 
Process Status from the CiscoWorks navigation tree. 

Note From the browser, only users with administrative privileges can start and stop 
processes.
From the server, only users with local administrative privileges can start and stop 
processes.

To stop processes from the browser:

Step 1 Select Server Configuration  > Administration > Process Management  > Stop 
Process. The Stop Process dialog box appears.

Step 2 From the dialog box, select System, to stop all processes, or select only the 
processes that you want to stop.

If you select specific processes, the process dependencies will also be stopped. If 
you select System, all processes except WebServer and JRunProxy Server will be 
stopped.

To start processes from the browser:

Step 1 Select Server Configuration> Administration > Process Management>Start 
Process. The Start Process dialog box appears.

Step 2 From the dialog box, select System, to start all processes, or select only the 
processes that you want to start. 

If you select specific processes, the process dependencies will not be started 
automatically.
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To stop all processes from the server, enter:

/etc/init.d/dmgtd stop

To all start processes from the server, enter:

/etc/init.d/dmgtd start

Caution Do not start the daemon manager immediately after you stop it. The ports used by 
deamon manager will be in use for some more time even after the daemon 
manager is stopped.

Calling the Technical Assistance Center (TAC)
If you had problems while installing CiscoWorks Common Services, before 
calling TAC:

• Make sure the system hardware and software requirements are met.

• Make sure the disk space is not full (/ (root), /opt, and /var partitions).

• Make sure the CD-ROM drive is not defective: mount the CD-ROM remotely 
on a different system and retry installation.

If the above conditions are met, and you still have problems, contact the Technical 
Assistance Center.

Tip Create a report and email the generated report to TAC.
From the CiscoWorks Server navigation tree, select Server Configuration > 
Diagnostics >  Collect Server Info.

TAC representatives may ask you to send them the installation log file, 
/var/tmp/ciscoinstall.log.
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Understanding Installation Messages
Table A-1 shows messages that might occur during installation and describes the 
reasons.

Table A-1 Installation Messages

Message Reason for Message User Action

Access problem with directory. The installation program cannot 
access product directory that you 
specified.

Check permissions on the 
directory directory. 

Bad installation root dir. You are trying to install the 
product in an unusable directory.

Install the product on a 
different directory.

Base package did not install. 
Exiting.

The installation program cannot 
install a required package.

Contact your technical support 
representative.

Cannot backup /etc/services, no 
change will be made.

The installation program could 
not copy /etc/services before 
modifying it.

Make sure there is enough 
space in /tmp.

Cannot become owner of file in 
directory directory.

You cannot become file owner in 
directory you specified as product 
root.

Check permissions on 
specified directory.

Cannot change ownership of 
library. Exiting.

The installation program could 
not write to the product root 
directory.

Check permissions on 
specified directory.

Cannot create directory. The installation program could 
not write to directory you 
specified.

Check permissions on 
specified directory.

Cannot create symlink: ln -s root 
/opt/CSCOpx.

The installation program cannot 
create link from /opt/CSCOpx to 
product root directory you 
specified.

Contact your technical support 
representative.

Cannot determine the CiscoWorks 
Common Services version.

Installation disk is corrupted. Contact your technical support 
representative.

Cannot determine the version of 
product.

The installation program was 
unable to determine product 
version.

Contact your technical support 
representative.
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Cannot make list of packages for 
installation.

The installation program suffered 
a major failure.

Contact your technical support 
representative.

Cannot make root dir. You do not have permission to 
make product directory you gave 
the program.

Check the permissions on the 
root or select another directory 
with enough permissions.

Cannot upgrade. Upgrade failed. Contact your technical support 
representative.

Copy setupdir to nmsroot failed. Installation program could not 
write to product root directory.

Check permissions on root.

Daemon Manager could not start. 
The port is in use.

The operating system has not 
reallocated the port.

Make sure all CiscoWorks 
processes are terminated 
(/usr/ucb/ps -ef | grep CSCO). 
Wait five to ten minutes, then 
try to restart the daemon 
manager.

Installation in progress. You are already running an 
installation on this system.

Run only one installation 
program at a time.

Missing file file. Installation program could not 
find file file.

Contact your technical support 
representative.

mkdir -p root failed. Exiting. Installation program was not able 
to create root specified.

Check permissions on root.

No syslog facility is available. No available Syslog facilities for 
CiscoWorks Common Services.

Make one of the facilities 
available.

Not enough disk space: root. You picked a product root in a file 
system with insufficient space to 
load our product.

Make at least 2 GB of disk 
space available on partition on 
which you install product.

OS version less than 
recommended or supported.

The operating system is not a 
supported version of Solaris.

Make sure you are running 
Solaris 2.7 or Solaris 2.8.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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Package verification failed: pkg 
aborting.

One of the packages loaded 
incorrectly.

Make sure the package in CD 
is correct. Use the command 
pkgchk -d disk/packages 
packagename

or

There may be a network 
problem, if you are installing 
over the network using a 
remotely mounted CD. 

Required JRE patches are 
unavailable on the system patch. 
Product will fail without these 
patches.

The installation program could 
not find required JRE patches.

Continue installation and 
install patches after the 
CiscoWorks Common 
Services product is installed. 

or

Stop product installation and 
install required patches before 
installing CiscoWorks 
Common Services.

Some files cannot get backed up, 
datafile missing.

During product upgrade, some 
key files were not found and 
cannot be restored.

Check other directories for the 
missing files.

Syslog is not running. The installation program was 
unable to start syslogd on this 
system.

Restart syslogd.

The components have dependency 
errors.

The installation suffered a major 
failure.

Contact your technical support 
representative.

There is no table of contents file. Installation disk is corrupted. Contact your technical support 
representative.

You must be logged in as root to 
install or uninstall this product.

You are not logged in as root. Log in as root and enter correct 
password.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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Current administration requires 
that a unique instance of the 
CSCOpkg package be created. 
However, the maximum number 
of instances of the package that 
may be supported at one time on 
the same system has already been 
met.

You are upgrading from previous 
CD One editions.

If this happens, change the 
property pair to 
instance=overwrite in the 
following file:
/var/sadm/install/admin/
default. 

The installer has discovered a 
problem with the DNS resolution. 
The DNS must resolve within 10 
seconds for the CiscoWorks 
Common Services to work 
properly.

The DNS is not being resolved or 
is not resolving properly.

Continue the installation as 
usual, then correct the DNS 
resolution problem.

/etc/hosts should be readable by 
all.

/etc/hosts should have read 
permission for all.

Continue with the installation. 
Correct the permissions of 
/etc/hosts after install.

/tmp permission should be 777. /tmp should have read/write 
permission for all.

Install will quit. Change /tmp 
permission and restart 
installation.

This is not a supported 
architecture. The product cannot 
be installed on this server.

The server architecture should be 
32-bit compatible.

The user has to install the 
product on a 32-bit compatible 
server.

Setup has detected the following 
product on the destination server. 

CWCS Integration Utility - 
Standalone.

CiscoWorks and SNMIM cannot 
co-exist.

Uninstall SNMIM from this 
system and restart Setup.

Permission of /usr/bin/at is 
$PERMS 

The minimum permission 
required is 4755.

Jobs cannot be scheduled if you 
do not have 4755 permissions for 
/usr/bin/at.

The minimum permission 
required is 4755. Change it 
after installation is complete.

Table A-1 Installation Messages (continued)

Message Reason for Message User Action
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Setting Up the Browser
If you have problems using the desktop, make sure the browser is configured 
correctly:

• The desktop buttons are active only if, Java and JavaScript are enabled. Make 
sure you enable Java and JavaScript as described in the “Preparing to Use 
CiscoWorks Common Services” chapter, “Configuring Server Systems” 
section on page 3-1.

Note If you are using Netscape Navigator, install it first and then install Java Plug-in.

Caution Uncheck Edit > Preferences > Advanced > Enable Java Plugin for 
Netscape Navigator 4.78 and 4.79.

• Make sure your cache is not set to zero. If you have browser problems, 
increase your cache settings as explained in the “Preparing to Use 
CiscoWorks Common Services” chapter, “Configuring Server Systems” 
section on page 3-1. 

• Do not resize the browser window while the desktop or main page is still 
loading. This can cause a Java error.
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Mounting and Unmounting on Solaris

This appendix describes how to mount the CiscoWorks Common Services 
CD-ROM on a Solaris system. It includes general information only. For more 
information, consult your Sun documentation.

You can install CiscoWorks Common Services from a CD-ROM mounted on the 
CiscoWorks Common Services server system or from a CD-ROM mounted on a 
remote Solaris system.

This appendix contains:

• Mounting a Local CD-ROM Drive

• Mounting a Remote CD-ROM Drive

• Unmounting the CD-ROM Drive

Mounting a Local CD-ROM Drive
Insert the CiscoWorks Common Services CD-ROM into the CD-ROM drive and 
do the following:

Step 1 Become the superuser by entering the command su and the root password at the 
command prompt, or log in as root. The command prompt changes to the pound 
sign (#).

If the /cdrom directory does not already exist, enter the following command to 
create it:

# mkdir /cdrom
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Step 2 Mount the CD-ROM drive. 

Note The vold process manages the CD-ROM device and performs the 
mounting. The CD-ROM might automatically mount onto the 
/cdrom/cdrom0 directory. 

If you are running File Manager, a separate File Manager window displays the 
contents of the CD-ROM. From the File Manager, double click on setup.sh file. 
The Action: Run box appears. Click OK to continue installation.

If the /cdrom/cdrom0 directory is empty because the CD-ROM was not mounted, 
or if File Manager did not open a window displaying the contents of the 
CD-ROM, verify the vold daemon is running by entering:

# ps -ef | grep vold | grep -v grep

If vold is running, the system displays the process identification number of vold. 
If the system does not display anything, restart the daemon by entering:

# /usr/sbin/vold &

If the vold daemon is running but did not mount the CD-ROM, stop the vold 
daemon and then restart it. To stop the vold process, you must know the process 
identification number. If you do not know the process identification number, you 
can get it by entering:

# ps -ef | grep vold | grep -v grep

Step 3 Stop the vold process by entering:

# kill -15 process_ID_number
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Step 4 Restart the vold process by entering:

# /usr/sbin/vold &

If you have problems using the vold daemon, enter the following command to 
mount the CD-ROM:

# mount -F hsfs -r ro /dev/dsk/cxtyd0sz /cdrom/cdrom0

where x is the CD-ROM drive controller number, y is the CD-ROM drive SCSI 
ID number, and z is the slice of the partition on which the CD-ROM is located.

You have now mounted the CD-ROM drive. See the “Installing CiscoWorks 
Common Services” chapter for instructions on installation.

Mounting a Remote CD-ROM Drive
Insert the CD One CD-ROM into the CD-ROM drive of the remote system and 
perform Steps 1 through 12 only on the remote system.

Step 1 Log in as root. The command prompt changes to the pound sign (#).

Step 2 If the /cdrom directory does not already exist, enter:

# mkdir /cdrom

Step 3 Mount the CD-ROM drive. 

Note The vold daemon process manages the CD-ROM device and performs the 
mounting. The CD-ROM might automatically mount onto the 
/cdrom/cdrom0 directory. 

If you are running File Manager, a separate File Manager window displays the 
contents of the CD-ROM. From the File Manager, double click on setup.sh file. 
The Action: Run box appears. Click OK to continue installation.
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If the /cdrom/cdrom0 directory is empty because the CD-ROM was not mounted, 
or if File Manager did not open a window displaying the contents of the 
CD-ROM, verify that the vold daemon is running by entering:

# ps -ef | grep vold | grep -v grep

If vold is running, the system displays /usr/sbin/vold. If the system does not 
display anything, restart the daemon by entering:

# /usr/sbin/vold &

If the vold daemon is running but did not mount the CD-ROM, stop the vold 
daemon and then restart it. To stop the vold process, you must know the process 
identification number. If you do not know the process identification number, you 
can get it by entering:

# ps -ef | grep vold | grep -v grep

Step 4 Stop the vold process by entering:

# kill -15 process_ID_number

Step 5 Restart the vold process by entering:

# /usr/sbin/vold &

If you have problems using the vold daemon, enter the following to mount the 
CD-ROM:

# mount -F hsfs -r ro /dev/dsk/cxtyd0sz /cdrom/cdrom0

where x is the CD-ROM drive controller number, y is the CD-ROM drive SCSI 
ID number, and z is the slice of the partition on which the CD-ROM is located.

Step 6 Use a text editor to create an /etc/dfs/dfstab file, if one does not exist. 

Step 7 Add the following line to the /etc/dfs/dfstab file:

share -F nfs -o ro /cdrom/cdrom0
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Step 8 Make sure your remote system is enabled as an NFS server by entering:

# ps -ef | grep nfs | grep -v grep

The output of this command shows whether the /usr/lib/nfs/nfsd and 
/usr/lib/nfs/mountd daemons are running. If they are not running, enable your 
system as an NFS server by entering:

# /etc/init.d/nfs.server start

If your system is enabled as an NFS server, enter one of the following:

# share

or

# shareall

Step 9 Go to the system where you want to install CiscoWorks Common Services.

Step 10 Log on as superuser by entering the command su and the root password, or log in 
as root.

Step 11 Create a /cdrom directory, if one does not already exist, by entering:

# mkdir -p /cdrom/cwcs

Step 12 To mount the CD-ROM drive, enter:

# /usr/sbin/mount -r remote_system_name:/cdrom/cdrom0 /cdrom/cwcs

You have now mounted the CD-ROM drive. See the “Installing CiscoWorks 
Common Services” chapter for installation instructions.
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Unmounting the CD-ROM Drive
After you complete the CiscoWorks Common Services installation, you must 
unmount the CD-ROM drive.

Unmounting a Local CD-ROM Drive
To unmount a local CD-ROM drive:

Step 1 As root, enter: 

# cd
# umount /cdrom/cdrom0 
# eject

Step 2 Remove the CD-ROM and store it in a safe place.

Unmounting a Remote CD-ROM Drive
To unmount a remote CD-ROM drive:

Step 1 As root, enter the following on the local system:

# umount /cdrom/cwcs

Step 2 As root, enter the following on the remote system:

# umount /cdrom/cdrom0

Step 3 Remove the CD-ROM and store it in a safe place.
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Password Information

This appendix provides information on the usage of passwords in CiscoWorks 
Common Services installation. It contains:

• CiscoWorks Admin Password

• CiscoWorks Guest Password

• CiscoWorks Common Services Database Password

• Licensing Database Password

CiscoWorks Admin Password
While entering the CiscoWorks Admin passwords:

• Use a minimum of 5 characters.

• Do not insert spaces between characters.

• Do not leave the password field blank.

CiscoWorks Guest Password
While entering the CiscoWorks Guest passwords:

• Use a minimum of 5 characters.

• Do not insert spaces between characters.

• Do not leave the password field blank.
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CiscoWorks Common Services Database Password
While entering the CiscoWorks Common Services Database passwords:

• Use a minimum of 5 and a maximum of 15 characters.

• Enter only valid characters. These are: a-z, A-Z, and 0-9.

• Do not start the password with a number.

• Do not insert spaces between characters.

• Do not leave the password field blank.

Licensing Database Password
While entering the Licensing Database passwords:

• Use a minimum of 5 and a maximum of 15 characters.

• Enter only valid characters. These are: a-z, A-Z, and 0-9.

• Do not start the password with a number.

• Do not insert spaces between characters.

• Do not leave the password field blank.

New Installation
The following rules apply for a new installation:

• In Express and Typical mode, if you do not enter the passwords, the 
installation generates random passwords.

• In Custom mode, you need to provide passwords.
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Upgrade Installation and Reinstallation
The following rules apply for upgrade and reinstallation:

• In Express and Typical mode, passwords from the earlier installation are 
retained. 

If you have not entered a password for CiscoWorks admin or guest user 
during the previous installation, a warning appears:

The password for the cwuser user is empty. For security reasons 
you must change the password as soon as you can from CiscoWorks 
Desktop.

Where cwuser is either CiscoWorks admin or guest.

• In Custom mode, you need to provide passwords.
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User Inputs for the Installation

This appendix provides information on the user inputs for CiscoWorks Common 
Services installation. It contains:

• User Inputs for Express Installation

• User Inputs for Typical Installation

• User Inputs for Custom Installation

User Inputs for Express Installation
CiscoWorks Common Services and the dependent applications are installed in 
/opt/CSCOpx/. In Express mode, you must provide the following information 
during installation:

Table D-1 User Inputs for Express Installation

Settings Value

Password for admin user No default values. Enter the admin 
password. For more information on 
passwords see “Password 
Information”
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User Inputs for Typical Installation
Enter the following information during installation in Typical mode:

User Inputs for Custom Installation
Enter the following information during installation in Custom mode:

Table D-2 User Inputs for Typical Installation

Settings Value

Destination folder The default location is /opt/CSCOpx. 

Select another location if you want to 
install in a specific location.

Components to install Select the components you want to 
install.

Password for admin user No default values. Enter the admin 
password. For more information on 
passwords see “Password 
Information”

Table D-3 User Inputs for Custom Installation

Settings Value

Destination folder The default location is /opt/CSCOpx.

Select another location if you want to 
install in a specific location.

Components to install Select the components you want to 
install.

Password for users admin and guest No default values. Enter the admin and 
guest password. For more information 
on passwords see “Password 
Information”
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Password for the CiscoWorks Common 
Services database

By default, the value is generated 
randomly. For more information on 
passwords see “Password 
Information”

Select one of the User Management 
modes: 

• Manage locally by CiscoWorks 
Common Services.

or

• Manage by Access Control Server 
(ACS).

If ACS mode is selected, enter the 
following server data:

• ACS Name

• ACS Port

• Admin User Name and Password

• Shared device key

By default, theUser Management 
mode is set to local, and ACS server 
data is empty.

If ACS mode is selected and if you 
leave the fields blank, the server name 
is set to tacacs.company.com and port 
is set to 49.

Table D-3 User Inputs for Custom Installation (continued)

Settings Value
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Apache certificate settings:

• SMTP server

• Host name

• Adminstrator’s e-mail address

• Country 

• State 

• City 

• Company 

• Organization 

Host name is mandatory.

Password for the Licensing database By default, the value is randomly 
generated. For more information on 
passwords, see “Password 
Information”

Table D-3 User Inputs for Custom Installation (continued)

Settings Value
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